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Chapter 1—Welcome

iClipboard is the ultimate clipboard manager. It keeps a history of everything you copy to the system-wide clip-
board from any application. When you need to go back and paste a clipping from the history, iClipboard ap-
pears from the side of your screen so you can preview and paste any clipping—you're no longer limited to
pasting just the last thing copied to the clipboard. For a list of new features in this version please visit our web
site at http://www.chronosnet.com.

Mac App Store Version Differences

iClipboard can be purchased directly from the Chronos website, hereafter referred to as the Chronos Version, or
from the Mac App Store using the App Store application built into OS X, hereafter referred to as the Mac App
Store Version. iClipboard is the same application with the same features regardless of where you purchase it.
There are, however, some key differences that the Mac App Store version introduces:

4+ Pasting. Normally, when you paste a clipping from iClipboard, the software puts the clipping on the sys-
tem clipboard and then simulates the pressing of the Command-V keystroke to paste the clipping for you.
If you purchased iClipboard from the Mac App Store, the software is not able to simulate the pressing of
the Command-V keystroke, so you'll need to do this yourself. Apple’s Mac App Store guidelines currently
disallow this feature due to sandboxing restrictions which prohibit simulated keystrokes. Apple enforces
sandboxing requirements to make your computer more secure by preventing rogue applications from ac-
cessing resources they're not supposed to. If you're using the Mac App Store version of iClipboard and
would like this functionality, we have a special non-sandboxed helper application that you can download
from our website that will paste the clipping for you: http://www.chronosnet.com/Products/iclipboard/
download.html

4+ Software Updates. The Mac App Store Version of iClipboard can only be updated via the Mac App Store.
This means if you originally purchased iClipboard from the Mac App Store, then it's not possible to down-
load and install an update from the Chronos website. Instead, you need to download the update from the
Mac App Store using the App Store application.

If any of these differences affect the instructions in this user guide, specialized instructions for the Chronos Ver-
sion of the software or the Mac App Store Version of the software will be provided.

System Requirements

4 MacOS Xv10.11.4 or later
4 50MB of available disk space

Installing iClipboard — Chronos Version

If you downloaded iClipboard from the Chronos website, you should see an iClipboard disk image on your
Desktop.

1) Open the iClipboard disk image on your desktop

2) Dragand drop the iClipboard application icon into your Applications folder or other folder of your choice.


http://www.chronosnet.com
http://www.chronosnet.com/Products/iclipboard/download.html

Installing iClipboard — Mac App Store Version

If you purchased iClipboard from the Mac App Store then OS X will automatically install the software on your
computer in your Applications folder. If you deleted the application and wish to reinstall it from the Mac App
Store, then the below steps describe how.

1) Open the App Store application.

2) Click Purchases at the top of the App Store window. You'll see a list of all the applications you've purchased
on the Mac App Store.

3) Locate iClipboard in the list of purchased applications and click Install.

Uninstalling iClipboard — Chronos Version
Delete the below items in the Finder to completely uninstall all of the software components and data related to
iClipboard.

1) TheiClipboard application. The iClipboard application is stored at the following location on your com-
puter unless you installed it elsewhere:

/Applications/iClipboard

2) YouriClipboard Database. This folder contains your iClipboard database. Don't delete this folder if you
want to keep all of the clippings in your clipboard history. It is stored at the following location on your
computer where ~ denotes your HOME folder:

~/Library/Application Support/Chronos/iClipboard

Uninstalling iClipboard — Mac App Store Version
Delete the below items in the Finder to completely uninstall all of the software components and data related to
iClipboard.

1) The iClipboard application. The iClipboard application is stored at the following location on your com-
puter unless you installed it elsewhere:

/Applications/iClipboard

2) Your iClipboard Database. This folder contains your iClipboard database. Don't delete this folder if you
want to keep all of the clippings in your clipboard history. It is stored at the following location on your
computer where ~ denotes your HOME folder:

~/Library/Containers/com.chronos.iClipboard

Transferring iClipboard to Another Computer

The occasion may arise when you need to transfer iClipboard along with your clipboard history to another
computer. The below steps describe this process.

1) Install iClipboard on your new computer, but don’t launch it. If you do launch iClipboard on your new com-
puter, it will create some support files/folders on the computer that will be replaced by the below steps (a
potentially dangerous operation since you'll lose the data in the replaced files). Make sure you abide by



your license when installing iClipboard on other computers. For more information on Chronos' licensing
see: http://www.chronosnet.com/company/licenseagreement.html

2) There are two items you'll need to copy from your current computer to your new computer. The items are
located at the following location on your computer where ~ denotes your HOME folder:

Your iClipboard Database. This folder contains your clipboard history. It is stored at the following
location on your computer where ~ denotes your HOME folder:

~/Library/Application Support/Chronos/iClipboard

If you purchased iClipboard from the Mac App Store, then this folder and the below preferences are located
here:

~/Library/Containers/com.chronos.iClipboard

+  Your Preferences. This file contains your preferences and settings for the software. It is located at the
following location on your computer where ~ denotes your HOME folder:

~/Library/Preferences/com.chronos. iClipboard.plist

You will need to copy these two items to the exact same location on your new computer. The method you
use to copy these items will vary upon your setup, size of the items, and computer expertise. If these items
aren't too big, it's probably easiest to copy them to a writeable CD/DVD or USB thumb drive and then copy
them from there to your new computer. If they're large in size, then you can first copy them to an external
hard disk and then copy them from there to your new computer. If your computers are networked, then
you can simply copy the files over your network.

Learning to Use iClipboard

To learn how to use iClipboard, consult these resources:

User Guide

This guide describes iClipboard’s features and shows how to use the program.

Onscreen Help

Help tags are available for many of the items in iClipboard. To see the help tags, let the mouse pointer rest over
an item for a couple of seconds.

Technical Support

Chronos provides various support options for iClipboard. See http://www.chronosnet.com/Support/index.html
for technical support options.

Web Resources

Go to http://www.chronosnet.com/Products/index.html to get the latest software and updates.


http://www.chronosnet.com/company/licenseagreement.html
http://www.chronosnet.com/Support/in-
http://www.chronosnet.com/Products/index.html

Chapter 2—Getting Started

iClipboard is little bit unique in that it’s a faceless background application. This means it doesn't appear in the
Mac OS X Dock and doesn’t have a regular menu bar. Instead it runs in the background and only appears when
needed.

Launching iClipboard

Since iClipboard runs in the background, you can normally just launch it once and then leave it running indefi-
nitely.
To launch iClipboard:

1) Double-click the iClipboard application. The application will launch and a Welcome window will appear.
The Welcome window contains a video you can watch to quickly get acquainted with the software. The
Welcome window will also walk you through a few setup and informational steps.

Welcome to iClipboard

User Guide

Need help? Check the User
Guide in the Help menu.
Open User Guide >

Welcome to iClipboard.

LITRN]
IANNNN

If you’re new to iClipboard, watch this Getting Started video to see Video Tutorials
everything you can accomplish with this remarkable application. Learn how to get the most out
of iClipboard.
Click to Play (») Learh more:>
| Show this window when iClipboard opens Continue

2) Click Close to close the Welcome window and start using the software. At the top of your screen in the
menu bar, you'll see an iClipboard icon which opens a menu. The iClipboard menu always remains in the
menu bar no matter which application you're currently working in. It provides convenient access to key
functionality as well as your recent clippings.



& iCLIPBOARD
Open Shelf 8L
Stop Recording
Preferences...
Help >

Quit iClipboard

KEYBOARD SHORTCUTS

Paste Blaster X %P "‘w*

' o PROJECTS
Unfiled -~

3) You'll also notice a tab on the edge of the screen.

iClipboard

B E1h

4) Click the tab. The tab is connected to a window called the Shelf which is described in the next chapter.

Drag Here

iClipboard



The first time you launch iClipboard, the software is automatically added to the list of Login ltems for your user
account. This means that iClipboard will automatically and conveniently launch each time you restart your
computer.

To view/edit your user account’s Login Items:

1) Open the System Preferences.

N

Click the Accounts preference pane.

w

)
)
) Select your account.
4)

Quitting iClipboard

Because iClipboard is a background application, you can't quit it like you would for most applications. Instead,
you use the iClipboard menu in the menu bar.

Click the Login Items tab.

To quit iClipboard:
1) Click the iClipboard icon in the menu bar and choose Quit iClipboard.

Changing Whether iClipboard Launches at System
Startup

You can change, at any time, whether or not you want iClipboard to be launched automatically whenever your
computer restarts.

To enable or disable iClipboard launching at system startup:
1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the General tab.

3) Select or deselect Enable at system startup.
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Chapter 3—Using iClipboard

iClipboard records everything copied to the system-wide clipboard (whenever you press Command-C or choose Edit
> Copy in any application). It will also remember everything copied between computer restarts, so you can liter-
ally go back weeks in time to find something that you copied. Each recorded item is called a clipping.

The Shelf

The Shelf, which appears on the edge of your screen or free floating wherever you last left it on your screen,
lists all of the clippings that have been recorded.

On/Off Button Search Field

Quickly and easily turn Find a clipping by
recording on/off. word or phrase.

Control Bar ___ Drag Zone

Quickly paste, preview, Drag new content

& delete clippings. here.

Tab I8 Using a highly advanced fingerprint

Click to open and close —— [ ==rreterons eome Clipboard History

the Shelf. unlocking your phone eesy.  ————— Rayjew and paste
recorded clippings
in the Shelf.

Project Menu
Record clippings in
projects you create.

Action Button
Access iClipboard
features.

Each clipping appears as a thumbnail that represents the content in the clipping. iClipboard can accurately
present thumbnails for standard clippings like the following:

Text (including rich text)

Graphics (supports all popular formats including jpeg, tiff, png, pdf, eps, etc.)
Web content (html/web archives)

Movies

Audio

+ee 44



4 Files

The Drag Zone is located at the top of the Shelf. The Drag Zone provides a place where you can drag new con-
tent directly to the Shelf.

To open the Shelf and view the clippings:
1) Click the tab on the Shelf. The Shelf will slide out from the side of the screen.

2) OR press the designated Open/Close Shelf shortcut (if the Shelf is in the floating position, you must use the
Open/Close Shelf shortcut). For more information on the open/close shortcut, see Opening/Closing The
Shelf Using a Shortcut.

3) ORclick the iClipboard icon in the menu bar and choose Open Shelf.

To close the Shelf:
1) Click the tab on the Shelf. The Shelf will close.

2) OR press the designated Open/Close Shelf shortcut (if the Shelf is in the floating position, you must use the
Open/Close Shelf shortcut).

3) ORclick the iClipboard icon in the menu bar and choose Close Shelf.

To change the position of the Shelf on the screen:
1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the General tab.

3) Choose a new screen position from the Position pop-up menu. You can choose to position the Shelf on the
left side or right side of your screen. If you have multiple monitors, you can choose to position the Shelf on
the left side or right side of your greater Desktop (you can't position the Shelf on the edge of a screen in
the middle of the greater Desktop). You can also choose a floating position which means the Shelf isn't tied
to the edge of your screen or Desktop and can be placed anywhere.

To change the appearance of the tab on the Shelf including its visibility:
1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the General tab.

3) Choose atab location from the Tab location pop-up menu. You can choose to have the tab appear at the
top, middle, or bottom of the Shelf. You can also choose to not have a tab at all which is useful if you find
that the tab covers other onscreen content.

To change the width or height of the Shelf on the screen:
1) Open the Shelf.

2) Click and drag on the resize control in the lower corner of the Shelf. If the Shelf is positioned at the bottom
of the screen, you can also resize the window by clicking and dragging in an upper corner of the Shelf.

To change the behavior of how the Shelf opens/closes:

Note: these steps are not applicable for a floating Shelf since a floating Shelf can only be opened and closed us-
ing the Open/Close Shelf shortcut.
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Normally, the Shelf opens/closes by clicking on its tab. You can, however, change this behavior so the Shelf
opens when you move your mouse to the edge of the screen and closes when you move your mouse off of the
Shelf.

1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the General tab.

3) SelectTurn hiding on

To enable/disable the Shelf:

If you don't plan on using the Shelf at all, you can disable it at any time and use other features in the software to
access your clippings.

1) Click the iClipboard icon in the menu bar and choose Preferences.

2) Select or deselect Enable Shelf.

Adding Clippings

iClipboard automatically records everything copied to the system-wide clipboard. The means whenever you press
Command-C or choose Edit > Copy in any application, the copied content is recorded by iClipboard and placed on

the Shelf. But there are other ways to get content onto the Shelf including dragging content to the Shelf and using
the controls within a clipping to grab selected content.

To drag content to the Shelf:

1) Click and drag content from any application to Shelf. If the Shelf is closed, it will automatically open and
you can drop the content on any clipping or on the Drag Zone. The clipping will be replaced with the new
content.

To control how the Shelf opens when dragging content to the Shelf:

Note: these steps are not applicable for a floating Shelf since a floating Shelf can only be opened and closed
using the Open/Close Shelf shortcut.

If the Shelf is closed when you drag content to it, the Shelf will need to open automatically for you. You can
choose to have the Shelf open automatically as soon as the mouse is over the Shelf’s tab or as soon as the
mouse hits the edge of the screen.

1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the General tab.
3) Choose either the Dock Tab or Screen Edge option.

To replace a clipping with selected content in the current application:

1) Select some content in your application.

) Open the Shelf

3) Locate the clipping whose contents you want replaced with the selected content from another application.
)

Click the Action button in the Control Bar and choose Grab Into Clipping.

13



To control how long clippings are shown in the Shelf:

The Shelf displays a reasonably-sized thumbnail presentation of each clipping to give you a good idea as to
what each clipping contains. The height of each clipping is limited so more clippings can be shown at a time
and to reduce scrolling. In the case of text clippings containing a lot of text, this may mean that the text clip-
ping in the Shelf isn't tall enough to show all of the text in the clipping.

This approach is practical and generally works well most of the time. However, if you prefer to see all of the text
in a clipping in spite of the height of the clipping being very tall and requiring a lot of scrolling, there is an op-
tion.

1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the General tab.
3) Select Show long clippings.

NOTE: if you choose to show long clippings, the software still imposes some practical limits for two reasons.
First, there are performance considerations for very tall clippings. Second, practical limits aim to prevent clip-
pings so tall that it might take a long time to scroll through the entire clipping.

Deleting Clippings

The occasion may arise when you want to delete a single clipping from the Shelf (like a password) or delete a
bunch of clippings at once.

To delete a clipping:
1) Locate the clipping that you want to delete.
2) Click the Delete button in the Control Bar.

To delete more than one clipping:

1) Select more than one clipping. Hold down the shift key to select multiple contiguous clippings. Hold down
the command key to select multiple clippings in a non-contiguous fashion.

2) Click the Action button and choose Delete Selected.

To delete all clippings in the history:
1) Choose “All” from the Projects pop-up menu.

2) Make sure that no clippings are currently selected. You can deselect a selected clipping by clicking on it or
by clicking in the Drag Zone.

3) Click the Action button and choose Delete All.

To delete all clippings in the selected project:
1) Choose a project from the Projects pop-up menu.

2) Make sure that no clippings are currently selected. You can deselect a selected clipping by clicking on it or
by clicking in the Drag Zone.

3) Click the Action button and choose Delete All

14



Pasting a Clipping Into Another Application

iClipboard keeps a history of everything copied to the system-wide clipboard so you can go back at any time
and use the clippings again. iClipboard makes it easy to paste clippings into other applications.

IMPORTANT TIP: Make sure that you're not holding down any keys on the keyboard when you paste a clipping.
This includes not holding down the Shift, Control, Option, and Command modifier keys.

To control whether text is pasted as formatted (rich text), plain text, or transformed text:

A lot of text that gets copied to the system-wide clipboard contains formatting like font information, styles
(bold, italics, etc.), line height info, etc. Formatted text is often referred to as rich text. When you use iClipboard
to paste formatted text into another application, you can choose to have iClipboard strip all the formatting
from the text and paste it as plain text. This is useful when you want the pasted text to take on the formatting
of the receiving document. There are also options to automatically transform the text to all uppercase, all low-
ercase, etc.

1) Open the Shelf.

2) Click the Text button in the Control Bar. When this button is blue, the text will be pasted as plain text. When
this button is its normal gray color, the text will be pasted in its original format. The text in the clipping will
change to reflect your current choice.

3) ORclick the Action button in the Control Bar and choose Text Transformation followed by the transforma-
tion of your choice. You can choose from transformations like converting all of the text to uppercase, low-
ercase, etc. The text in the clipping will change to reflect your choice.

To paste a clipping into another application:

1) Switch to the application where you want the clipping pasted and then click in the document where you
want the clipping pasted.

2) Open the Shelf.
3) Double-click the clipping you want to paste.
To paste a clipping into another application using the Paste button:

1) Switch to the application where you want the clipping pasted and then click in the document where you
want the clipping pasted.

2) Open the Shelf,
3) Locate the clipping you want to paste.

4) Click the Paste button in the Control Bar.

To paste more than one clipping consecutively:

1)  Select more than one clipping. Hold down the shift key to select multiple contiguous clippings. Hold down
the command key to select multiple clippings in a non-contiguous fashion.
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2) Click the Action button and choose Paste Selected.

To paste all the clippings in the current project or the entire history:
1) Choose a project or “All” from the Projects pop-up menu.

2) Make sure that no clippings are currently selected. You can deselect a selected clipping by option-clicking
on it or by clicking in the Drag Zone.

3) Click the Action button and choose Paste All.

To paste a clipping into another application using drag and drop:

1) Switch to the application where you want the clipping pasted.

2) Open the Shelf.

3) Click and drag the clipping from the Shelf to the document where you want the clipping pasted.

Previewing a Clipping

The Shelf only displays a thumbnail of each clipping since space is limited. If you need to see a larger version of
a clipping, you can bring up a preview.

http://www.apple.com/macbook-pro/
captured from Safari on 5/10/16 at 2:10 PM
(shown at 50%)

Representation: Cocoa TIFF
Size: 11.1 MB of 29.2 MB

iClipboard can show you previews of the following standard kinds of clippings:

Text (including rich text)

Graphics (supports all popular formats including jpeg, tiff, png, pdf, eps, etc.)
Web content (html/web archives)

Movies

Audio

+++ 4+
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4 Files

The previews are dynamic in that movies and audio will play, and files will show you a Mac OS X Quick Look
preview of the file’s contents when available. If iClipboard tries to preview a non-standard or proprietary clip-
ping, the following preview symbol will appear:

PREVIEW

NOT AVAILABLE

This symbol simply means that iClipboard can't display the contents of the clipping, but the clipping is still valid
and every bit as usable as any other clipping.

The preview will also show you other pertinent information about the clipping depending upon the kind of
clipping:

The kind of clipping (text, image, movie, etc.)

The size of the clipping in bytes

The document and application where the clipping came from

The URL where the web clipping came from, i.e. www.chronosnet.com
The date and time the clipping occurred

+++ 4+

To preview a clipping:
1) Locate the clipping you want to preview.

2) Click the Preview button in the Control Bar.

To dismiss a preview:

1) Click the Preview button in the Control Bar or click in the Shelf.

Choosing a Preview Representation

When content is copied to the system-wide clipboard, the content might appear on the clipboard in different
data representations. For example, if you copy some text in your word processor, your word processor might
put plain text, rich text, and Unicode representations of the text on the clipboard to make it easier for other
applications to use. When you later paste the text in a different application like a spreadsheet program, that
program can decide which representation of the content to paste. For example, an older spreadsheet program
might not support Unicode text so it would use the plain text representation.

When you preview a clipping in iClipboard, the preview will show you all the different representations of the
content contained in the clipping. The representation currently being displayed is selected in the Representa-
tion button at the bottom of the preview.

17



Representation: Cocoa TIFF
Size: 11.1 MB of 29.2 MB

If you click on the Representation button, you'll see all of the different representation stored in the clipping:

TEXT
Carbon Plain Text
Carbon Stylized Text
Carbon UTF-16 Plain Text
Carbon UTF-16 Stylized Text
Cocoa Rich Text
Cocoa String
Rich Text
Traditional Mac Plain Text
UTF-16 Big Endian Plain Text
UTF-8 Plain Text

WEB ARCHIVE

v Cocoa Web Archive

Web Archive

OTHER
Type “com.adobe.indesign-import-styl”
Type “com.adobe.indesign-import-ustl”

The representations are organized for your convenience into broad categories like text, images, web archives,
etc. You might not recognize some of the names of these representations because they're used internally by
programmers and some are proprietary, but many are identifiable.

ADVANCED REPRESENTATION INFORMATION. You'll likely notice that many representations begin with ei-
ther “Carbon” or “Cocoa”. Carbon representations are generally used by older applications that were originally
ported from Mac OS 9. Since some older applications still rely on Carbon representations, some modern ap-
plications still put these representations on the clipboard even though they're slowing becoming deprecated
with each new Mac OS X release. Cocoa representations were the modern replacement for Carbon representa-
tions, but they too have been superseded by Apple in recent years by an even better standard known as Uni-
versal Type Identifier or UTI. The UTI representations appear without any prefix so when you see “Rich Text”; it's
really a UTI Rich Text representation.

You can select a different representation to see a preview of that representation. Suppose, for example, that
you copy an image from a web page in your web browser application. It might show up on your Shelf like this:

18
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When you preview this clipping, iClipboard, will do its best to choose the representation of the content that it

thinks will best represent the clipping to you. In this case, it will choose the “Cocoa Tiff” graphics file representa-
tion.

ttp://www.macworld.com/article/: 2/m /how-to- -one-mac-in- were originally ported from Mac OS 9. Since
h R/l acworld.com/article, 396596 acs/how-to-use-one-mac-in- some older applications still rely on Carbon
captured from Safari on 5/10/16 at 2:34 PM

formats, some modern applications
1 characters

Representation: Cocoa Rich Text with Attachments
Size: 55.3 KB of 1.3 MB

However, if you look at the listing of representations, you'll see that it also has a plain text flavor of the image
called, “public.utf8-plain-text”. Why would it have a text representation of an image? Your web browser also
stored a text representation for the image in case you tried to paste the image into a text field. Since a text field

can't accept an image, your web browser figured you might appreciate the URL of the image being pasted in-
stead.

19



some older applications still rely on Carbon
formats, some modern applications

captured from Safari on 5/10/16 at 2:34 PM . - -
88 characters L1 ] ]

http://www.macworld.com/article/

http://core0.staticworld.net/images/article/2015/12/mac-family-
stock-100635113-large.jpg

Size: 88 bytes of 1.3 MB

Representation: = Cocoa String

Starting/Stopping Recording

There may be times when you don’'t want iClipboard to record data that is copied to the system-wide clipboard.
In such cases, you can temporarily stop and resume recording from either the Shelf or the icon in the menu bar.

To start/stop recording from the Shelf:
1) Slide the on/off switch in the upper left-hand corner of the Shelf to the desired position.

E

To start/stop recording from the icon in the menu bar:

1) Choose Start/Stop Recording from the icon in the menu bar.

A DD 3 ) D 100% e
i iCLIPBOARD
Open Shelf 3L CNES
Stop Recording
Preferences...
Help >
Quit iClipboard

1

Opening a Clipping

You can open a clipping in another application if you want to edit the clipping or work with it. iClipboard will
open the clipping using the default application for the type of data stored in the clipping. For example, a rich

20



text clipping will most likely be opened by TextEdit; a jpeg image will most likely be opened by Preview or oth-
er graphics editing program; and so forth.

To open a clipping:
1) Locate the clipping you want to open.

2) Click the Action button in the Control Bar and choose Open in Default Application.

Opening/Closing The Shelf Using a Shortcut

Some may find it more convenient to open and close the Shelf using a shortcut instead of clicking the tab on
the Shelf.

To change the shortcut that opens and closes the Shelf:

1) Click the iClipboard icon in the menu bar and choose Preferences.

N

)
) Select the Shortcuts tab.

) Clickin the Open/Close Shortcut field.
)

Enter a new shortcut or click Clear to delete the existing shortcut.

w

4

Setting Grab and Paste Sounds

Whenever you grab content onto the Shelf (either by dragging or the Grab button), a special grab sound will
play so you know the content was grabbed. Likewise, whenever you paste a clipping into another application, a
special paste sound will play. You can change the sound that plays when these events occur or you can turn off
the sound effect altogether. You can also adjust the volume that these sounds play at in relation to the system
volume setting.

To change the grab and paste sounds:

1) Click the iClipboard icon in the menu bar and choose Preferences.

N

Select the Sounds tab.

w

)
)
) Choose a new Grab or Paste sound from the appropriate pop-up menus.
)

4) Adjust the volume of these sounds as desired.

Setting The Copy Sound

iClipboard records everything copied to the system-wide clipboard. This means whenever you press Command-C or
choose Edit > Copy in any application, the copied content is recorded by iClipboard and placed on the Shelf. When
this occurs, you can optionally choose for the software to play a sound of your choice.

To change the copy sound:
1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the Sounds tab.

3) Choose a new Copy sound from the Copy clipping sound pop-up menu.
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4) Adjust the volume as desired.

iClipboard in The Menu Bar

The iClipboard menu always appears in the menu bar at the top of your screen. This menu displays clippings in
all of your projects as well as recent clippings from your history. You can use this menu to quickly paste any of
these clippings into the current application.

L O % 0 <O 100%@ 5:32PM

iCLIPBOARD
Open Shelf L
Stop Recording
Preferences...
Help »

Quit iClipboard

KEYBOARD SHORTCUTS

Paste Blaster X 3#P
PROJECTS
Unfiled >

RECENT CLIPPINGS

To paste a clipping into another application using iClipboard in the menu bar:

1) Switch to the application where you want the clipping pasted.

2) Click the iClipboard icon in the menu bar.

3) Choose a clipping from one of your projects or from the list of Recent Clippings.
To change the number recent clippings that appear in the iClipboard menu:

1) Click the iClipboard icon in the menu bar and choose Preferences.

2) Select the General tab.

3) Choose a limit from the Menu bar limit pop-up menu.



Chapter 4—Advanced Features

iClipboard has many advanced features that help you manage you clippings and use clippings in useful ways.

Editing Clippings

You can edit text and web clipping directly from the Shelf. This is useful if you need to make a correction or
change to a clipping before pasting it into another application.

To edit a text or web clipping:

1) Locate the text or web clipping you want to edit.

2) Click the Action button in the Control Bar and choose Edit.

Assigning Names To Clippings For Pasting

You can assign a name to any clipping to help you more easily identify clippings in the future. The name you
assign to a clipping appears beneath the clipping (“The Ritz-Carlton”):

Holding Your Reservation

* We will need a credit card

prepayment to reserve your room.

® To ensure that you receive this special
rate, we will charge your credit card a
prepayment of 373.14 USD (your room

charge plus tax).

» ‘ Ritz-Carlton Reservation

To assign a name to a clipping:
1) Locate the clipping you wish to assign a name to.

2) Click the Action button in the Control Bar and choose Assign Name.

Searching

You can easily search all of your clippings or just the clippings in a certain project for a particular word or
phrase. iClipboard searches all of the text contained in text and web (html and web archive) clippings. iClip-
board will also search the name assigned to your clippings as well as any other pertinent data in clippings like
filenames for images, movies, etc.



To search your clippings:
1)  Open the Shelf.
2) Choose a project from the Project button at the bottom of the Shelf.

3) Enteraword or phrase in the Search field. Only the clippings containing the word or phrase you entered
will be shown.

Rapid-Fire Copying/Pasting

Mac OS X only lets you put a single clipping on the system-wide clipboard at a time. This means if you're copy-
ing and pasting lots of information between applications that you have to switch between applications every
time you copy or paste something. iClipboard solves this problem by letting you copy multiple items to its his-
tory at a time; switch applications once; and then paste all of the items from the history one at a time. For ex-
ample, you can press a special shortcut five different times in your web browser to copy five different para-
graphs, and then you can switch to your word processor and press a special shortcut five times to paste the five

clippings.

To copy and paste multiple clippings without switching applications needlessly:

1) Switch to the application and/or document where you want to copy information.
2) Select the content you want to copy.

3) Press the special Copy shortcut instead of pressing Command-C. A special lightning bolt symbol will ap-
pear next to the clipping in the Shelf so you know it’s part of a sequence of clippings that you want to
rapidly paste into a different application.

Valet parking: $30.00,
overnight/short term

4) Repeat steps 2 and 3 for each piece of information you want to copy.

5) Switch to the application and/or document where you want to paste all of the clippings and then click in
the document where you want the clippings pasted.

6) Press the special Paste shortcut instead of pressing Command-V. The oldest clipping in the sequence of
clippings on the Shelf will be pasted and the lightning bolt symbol next to it will disappear.

7) Repeat step 6 for each special clipping on the Shelf. iClipboard will beep if you press the Paste shortcut and
there aren't any more clippings in the sequence on the Shelf.

To specify the rapid-fire Copy and Paste shortcuts:

1) Click the iClipboard icon in the menu bar and choose Preferences.

N

Select the Shortcuts tab.

w

)
)
) Click in the Copy Shortcut field or the Paste Shortcut field.
)

4) Enter a new shortcut or click Clear to delete the existing shortcut.
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Paste Blaster

Most Mac OS X users are familiar with the Command-Tab shortcut which is used to switch between your run-
ning applications. If you're familiar with how this Mac OS X feature works, then you already know how to use
the Paste Blaster. Simply press a special shortcut and large previews from the selected project in your clipboard
history will appear on your screen. Press the special shortcut repeatedly until the clipping you want to paste is
selected and presto, the clipping will automatically be pasted into whatever application you're using.

Project B ﬁg 3 iClipboard Original Format

Your Photo Stream takes
care of itself.

3%

Your Photo Stream in iCloud is a
rolling collection of your last 1000
photos, ready to view whenever you
want with a single click.2 Once your
photos have been imported from
your Photo Stream into your library,
you

We'll help you choose the
perfect Mac.

If you want to learn more about Mac
features and configuration options
we can help. Our Specialists will take
the time to understand your needs
and answer all your questions. We
don’t work on commission, so we
care o

To use the Paste Blaster:

1) Press the Paste Blaster shortcut (the default shortcut is Option-Command-P). The Paste Blaster will appear
and the Cancel button will be selected.

2) Choose a project from the Project button in the upper left-hand corner of the Paste Blaster.

3) Choose the representation that you'd like any pasted text clippings to use in the upper right-hand corner of
the Paste Blaster.

4) Continue to hold down the modifier keys (Option & Command in this case). As long as these modifier keys
are held down, the Paste Blaster will remain on the screen.

5)  With the modifier keys held down, repeatedly release and press the main key of the shortcut (“P”in this
case). Each time you press the main key, the selected clipping in the Paste Blaster will advance. NOTE: you
also hold down the Shift modifier key to reverse the order that clippings are selected in.

6) Release the modifier keys to paste the currently selected clipping.
7)  ORclick on the clipping you wish to paste (be sure to release the modifier keys so the paste can occur).
To specify the Paste Blaster shortcut:

1) Click the iClipboard icon in the menu bar and choose Preferences.
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2) Select the Shortcuts tab.
3) Click in the Paste Blaster Shortcut field.

4) Enter a new shortcut or click Clear to delete the existing shortcut.

To enable/disable the Paste Blaster:
1) Click the iClipboard icon in the menu bar and choose Preferences.

2) Select/deselect Enable Paste Blaster.

To limit the number of clippings in the Paste Blaster:
1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the General tab.

3) Choose a limit from the Paste Blaster limit pop-up menu.

Blacklisting Applications

You may not want to record clippings from certain applications. For example, you may not want to record the
passwords that are copied to the system-wide clipboard when you're using the Keychain Access application
that is part of Mac OS X. You can tell iClipboard to ignore clippings that originate in certain applications. This is
referred to as blacklisting an application.

To blacklist an application:

1) Click the iClipboard icon in the menu bar and choose Preferences.

w N

)

) Select the Blacklist tab.

) Click Add (+) to add an application that you wish to ignore or blacklist.
)

4) Click Delete (-) to remove the selected application from the list of applications being blacklisted.
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Chapter 5—Projects

iClipboard can record and group clippings into projects that you define. For example, a scientist might switch to
her Research project when she’s doing research on the web and switch to her Report project when she’s work-
ing on weekly progress reports. Projects make it possible to compartmentalize your work.

The Project button at the top of the Shelf indicates the project that you're currently recording into. The Shelf
shows you all of the clipping in the currently selected project.

NOTE: Every clipping is assigned to a project. The default project is the Unfiled project described below.

The “Unfiled” Project

iClipboard creates a special Unfiled project for you that can’t be renamed, deleted, or locked. Whenever iClip-
board records a new clipping, it will automatically be placed in this Unfiled project unless you have another
project selected in the Project button at the bottom of the Shelf.

You can think of the Unfiled project as the project that holds all of the clippings that haven't yet been filed
elsewhere. If you don’t want to organize your clippings, you can, of course, just leave them all in the Unfiled
project.

The “All” Project

The Project button in the Shelf lists an All project. Select this project when you want the Shelf to show every
clipping regardless of which project it belongs to. In other words, “All” represents the master history of clip-
pings. When “All"is selected and a clipping is recorded, the clipping is assigned to the Unfiled project.

Setting Limits

iClipboard can conceivably record every clipping copied to the clipboard forever. As you might imagine, doing
so would consume a lot of memory and disk space. Fortunately, iClipboard lets you limit the number of clip-
pings recorded by limiting the clippings recorded into the Unfiled project. iClipboard only limits this project
because it assumes any clippings you save to other projects you want to keep forever. There is also an option to
delete all of the clippings in the Unfiled project whenever iClipboard quits to prevent private clippings from
being remembered between launches.

To limit the total number of recorded clippings in the Unfiled project:



You can limit the clippings recorded into the Unfiled project by quantity or by time period. For example, you
can tell iClipboard to only record the most recent 100 clippings or you can tell iClipboard to only keep clippings
from the past week.

1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the General tab.

3) Choose a limit from the Unfiled limit pop-up menu.

To limit the size of clippings that are recorded into any project:

You may also want iClipboard to ignore clippings if they are exceedingly large. For example, a graphics designer
that works with large graphic files may not want iClipboard to record a 50 MB image. Likewise, a movie editor
might not want a 400 MB movie clip recorded since doing so may affect the computer’s performance. iClip-
board lets you choose to record all clippings regardless of size or just those below a certain size.

1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the General tab.

3) Choose a limit from the Ignore clippings pop-up menu.

To clear all of the clippings in the Unfiled project when quitting:

iClipboard typically records everything copied to the system-wide clipboard including passwords and poten-
tially private information. Normally, these clippings will be captured to the Unfiled project unless you've stored
these clippings in a different project. For security and privacy purposes, you can choose to have iClipboard au-
tomatically delete all clippings in the Unfiled folder whenever the software quits. For example, when you
restart or shut down your computer, iClipboard can automatically clear all of the clippings in the Unfiled project
to make sure that private clippings aren’t remembered between launches of the software.

1) Click the iClipboard icon in the menu bar and choose Preferences.
2) Select the General tab.
3) Select Clear Unfiled When Quitting.

Working With Projects

Working with projects is easy since almost everything to do with projects starts with the Project button at the
bottom of the Shelf.

To add a new project:

1) Choose Edit Projects from the Projects pop-up menu. A sheet for editing projects will appear.

w N

Enter the name of your project and press Return.

)
) Click Add (+). A new project will be added to the list of projects.
)
4)

Select the Lock button if you wish to prevent clippings from being added or moved to this project. See
Locking a Project for more information.

5) Click Done to exit the sheet.
To delete a project:

1) Choose Edit Projects from the Projects pop-up menu. A sheet for editing projects will appear.
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2)
3)
4)

Select a project in the list.
Click Delete (-).

Click Done to exit the sheet.

To rename an existing project:

1

w N

)
)
)
4)

Choose Edit Projects from the Projects pop-up menu. A sheet for editing projects will appear.
Double-click a project in the list.
Edit the name of the project and press Return.

Click Done to exit the sheet.

To switch projects:

1)

Choose a project from the Projects pop-up menu. The Shelf will display all of the clippings that have al-
ready been recorded to the selected project.

To move clippings into project:

1)

2)

Select the clippings you want to move to a different project. Hold down the Shift key to select multiple
contiguous clippings. Hold down the Command key to select multiple clippings in a non-contiguous fash-
ion.

Click the Action button, choose Move To, then choose the project you want to move the selected clippings
to.

To copy clippings into project:

1)

2)

Select the clippings you want to copy to a different project. Hold down the Shift key to select multiple con-
tiguous clippings. Hold down the Command key to select multiple clippings in a non-contiguous fashion.

Click the Action button, choose Copy To, then choose the project you want to copy the selected clippings
to. Since each selected clipping has now been duplicated, it will show up multiple times in the “All” project.

Locking a Project

You can lock a project to prevent clippings from being added or moved to it. A locked project can be identified
by the lock icon that appears next to the project name in the Project button at the top of the Shelf.
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If a locked project is selected in the Project button at the top of the Shelf and a new clipping is recorded, the
clipping will be added to the Unfiled folder instead of the locked folder.

Note: the Unfiled project cannot be locked because it must always be available to accept newly recorded clip-
pings.

To lock a project:

1) Choose Edit Projects from the Projects pop-up menu. A sheet for editing projects will appear.

2) Selecta projectin the list.

3) Select the Lock button.

To unlock a project:

1) Choose Edit Projects from the Projects pop-up menu. A sheet for editing projects will appear.
2) Selecta projectin the list.

3) Deselect the Lock button.

Sorting

By default, your clippings appear in the order they were recorded, but the following sort order options are
available to you:

Date. Choose this option to sort your clippings by the date each was recorded.

Name. Choose this option to sort your clippings by the name, if any, assigned to each clipping.

Project. Choose this option to sort your clippings by the project that each belongs to.

Kind. Choose this option to sort your clippings by the kind of data stored in the clipping (text, image, movie,
etc.).

Application. Choose this option to sort your clippings by the application that the clipping was recorded from.
User-Defined. Choose this option to sort your clippings in the order that you drag them. The order that you
drag them is remembered on a project-by-project basis including the All project.

++ +e e

The sort order you choose is used in the Shelf, the Paste Blaster, and the iClipboard menu in the menu bar.
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To change the sort order:

1

w N

)
)
)
4)

5)

Click the iClipboard icon in the menu bar and choose Preferences.

Select the General tab.
Choose your desired sort order from the Sort by pop-up menu.

Select the Sort in ascending order button if you want to sort in ascending order. This option does not apply
if you choose the User-Defined sort option.

If you've chosen the User-Defined option, then you can select a project in the Shelf and drag and drop the
clippings in the order you want them.
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